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HardingFPA HD User's Manual
Thismanual details how to use the HardingFPA HD system.

For HardingFPA HD Version 3.6.0

Documentation date: 19/12/2012.
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Overview
TheHardingFPA HD is the newest version of the HardingFPA Broadcast Flash and Pattern Analyser,

which is capable of analysing High Definition (HD, up to 1080i60) material via capture card over SDI and

HDMI connections depending on the capabilities of the installedCapture Card. It analyses using new

Version 3 analysis algorithms, which have been designed specifically for HD standards and file analyses.

For compatibility the software can be switched to use SD Legacy Mode, which allows SDmaterial to be

analysed using Version 2.5 analysis algorithmswhich are the same as in the previous 2.54/2.57 versions

of theHardingFPA, and Version 1.x of theHardingFPA-X file-based systems.

An additional file-based add-on for the HardingFPA HD is available, which has the ability to analyse files

from within theHardingFPA HD. It is compatible with many file formats including MXF, mov and AVI.

The HardingFPA HD is also designed to integrate into an existing HardingFPA-X system, allowing quick

access to the results generated through theHardingFPA-X suite of applications.

PAP/PAR/PAM files generated by the HardingFPA HD are the standard Harding results format, and

additionally be opened using the HardingFPA-X Viewer, which is a free download from

www.hardingfpa.com.

http://www.hardingfpa.com/
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System Requirements
The HardingFPA HDwill run on standard PC hardware, with a compatible capture card running either

Windows® 7 (or later) or a Mac running OS X 10.6 (or later).

The provided HASP USB software protection key will need to be inserted into the computer for the

application to run, as it will not operate without it.

PLEASE NOTE that a full-height (but not necessarily full-length) PCIe non-graphics card slot is

essential in order to accommodate the SDI data capture card. Note some computers although

offering PCIe slots are programmed to only accept graphics cards in those slots.

Minimum hardware requirements:

Intel Core 2 Quad Q9400 (2.66GHz, 1333MHz, 6MB)

Memory : 2048MB (2x1024) 800MHzDDR2 Dual Channel

Hard Drive : 250GB (7200Rpm) Serial ATAII 3Gb/s

Windows® 7 Professional 32 Bit

(Note future releasesmay require additional resources).

Recommended hardware requirements:

Intel Core i7-860 with VT (2.80GHz, 8M)

Memory: 4GB (2x2048MB) 1333MhzDDR3 Dual Channel

Hard Drive: 320GB 3.5inch Serial ATA (7,200rpm)

The software is intended for use on one computer only, and will lock itself to the machine it is running on

(See Licensing).
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Windows

To reduce the risk of dropped frames during capture (which causes the analysis to abort), it is

recommended that the main hard disk drive in the computer is defragmented and Scheduled

Defragmentation is disabled before running the software, as disk buffering and results saving creates

significant disk activity. To disable defragmentation, right-click on the disk and select Properties. Select

the Tools tab and click inDefragment.

ClickConfigure Schedule...
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Uncheck the box toRun on schedule.

Services

It is recommended that the following services are disabled on the computer in order to reduce the risk of

dropped frames due to unnecessary disk activity:

l Windows Search Indexing Service

l Volume ShadowCopy Service (VSS)

l SPP Notification Service

To switch these services off, open theControl Panel, System and Security, Administrative Tools, then

clickServices (shown in the screenshot below) and then switch them all the aforementioned services to

“disabled”.
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These are shown on the services screen below:
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To disable the services, right-click on each one, select “properties” and then choose “Disabled” from the

drop-downmenu (shown below)..



Cambridge Research Systems Ltd.

Page 9 of 105

It is also recommended to set the computer's “Power options” to “High Performance” – shown below.
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OS X

To reduce the risk of dropped frames during capture (which causes the analysis to abort), OS X'sSpotlight

Searchwill be disabled on installation of the software.

This is done bymoving the file

/System/Library/LaunchDaemons/com.apple.metadata.mds.plist into

/System/Library

To reinstate Spotlight Search:

l Open Terminal

l Type the following commands:

l sudo mv -f /System/Library/com.apple.metadata.mds.plist /Sy-

stem/Library/LaunchDaemons

l sudo launchctl load

/System/Library/LaunchDaemons/com.apple.metadata.mds.plist
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Accepted Video Formats
The HardingFPA HDwill accept the following video formats over SDI:

l NTSC 720x486i60 – i.e. 720 x 486 pixels interlaced at 60 fields per sec.

l NTSC 720x486i50

l PAL 720x576i48

l HD 1280x720p50 – i.e. 1280 x 720 pixels progressive at 50 frames per sec.

l HD 1280x720p59.94

l HD 1280x720p60

l HD 1920x1080p23.98

l HD 1920x1080p24

l HD 1920x1080p25

l HD 1920x1080p29.97

l HD 1920x1080p30

l HD 1920x1080i50

l HD 1920x1080i59.94

l HD 1920x1080i60
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Movie Files
The system will open and attempt to analyse anymovie file for which the computer it is installed on has

the codec. There are number of codecs included (see below). Any further codecs required will need to be

installed on the computer(s) running the application.

Only movie files with the following extensions will be analysed:

*.avi, *.mov, *.mpg, *.mpeg, *.m2v, *.mp4, *.vob, *.wmv, *.mxf, *.flv, *.qt, *.ps, *.3gp, *.mkv,

*.m2ts

In general, if the file can be viewed correctly using QuickTime (or WindowsMedia Player) on the computer

that the application is running on, and is within the accepted limits for frame size and frame rate (see

below), then the application will be able to analyse it.

The list of accepted frame sizes and frame rates are as follows:

Legacy SD analysis frame sizes:

320x240, 352x288, 384x288, 640x480, 640x486,

702 – 720 x 480

702 – 720 x 486

702 – 720 x 576

768x576

Legacy SD analysis frame rates:

25, 29.97

Version 3 SD analysis frame sizes supported:

320x240, 352x288, 352x240, 384x288, 480x360, 640x360, 960x540  640x480, 854x480, 640x486,

854x486,
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702 – 720 x 480

702 – 720 x 486

702 – 720 x 576

768x576, 1024x576,

Version 3 HD analysis frame sizes supported:

960x720, 1280x720, 1440x1080, 1920x1080

Version 3 analysis frame rates:

24, 25, 29.97, 30, 50, 59.94, 60

The HardingFPA-X uses the following frameworks to access video frames:

l FFmpeg

l QuickTime

l DirectShow (onWindows only)

When presented with a file, a framework is selected based on the movie file extension.

MXF Files

An attempt is made to open the MXF file using the internal MXF library. This library has support for OP1A

and OP ATOM wrapped MXF files with the following codecs:

l D10 (IMX)

l DV

l DVCPRO

l DVCPRO HD

l DNxHD

l AVC Intra
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If the internal MXF library does support the MXF file format, then the FFmpeg library is used to decode

these frames. The MXF library includes support for AVIDMXF files as well asMXF time code tracks.

If the MXF file format is not supported by the internal MXF library, an attempt is made to use the FFmpeg

library to open the file directly.

OnWindows platforms, if all else fails an attempt to use DirectShow (using any codecs installed in the

system) will be made. If this is successful, an attempt will be made to use the VITC information, if any,

embedded in the video material.

MOV Files

The QuickTime library will be used to open QuickTime files. File support depends on the QuickTime

codecs that are installed on the computer used for analysis. The QuickTime library supports QuickTime

timecode tracks. The system does not support multi-track QuickTime movies.

Other Files

Firstly the use of FFmpeg is attempted, followed by an attempt (onWindows platforms only) to use the

DirectShow framework, and finally the QuickTime framework.

Why use FFmpeg?

l FFmpeg provides a uniform set of embedded codecs that allow for consistent results across dif-

ferent platforms and installations.

l If a previous version of the application used DirectShow or QuickTime, and a newer version uses

FFmpeg, there is a possibility that the results will differ due to the slight differences between codec

algorithms. The use of FFmpeg in current and future versions of the HardingFPA product range will

mitigate this problem.

l FFmpeg in many cases removes the requirement of purchasing 3rd party MXF support and codecs

as the MXF library, in conjunction with FFmpeg, now fulfils this requirement.

The FFmpeg library supports the following codecs:

D10 (IMX), DV, DVCPRO, DVCPROHD, DNxHD, MPEG1VIDEO, MPEG2VIDEO, H261, H263,

RV10, RV20, MJPEG, MJPEGB, MPEG4, MSMPEG4V1, MSMPEG4V2, MSMPEG4V3, WMV1,
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WMV2, H263P, H263I, FLV1, H264, INDEO3, VP3, THEORA, ASV1, ASV2, FFV1, MSVIDEO1,

SNOW, XVID, FFVHUFF, INDEO2, FRAPS, VP5, VP6, VP6F, FFH264.

The decision tree that is used to decide which framework to use is shown in the flowchart below:
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Capture Cards
The software is compatible with the following video capture cards. Support for more cards and other

manufacturers is planned for the future.

l BlackMagic Design Decklink SDI

l BlackMagic Design Decklink SDI Duo

l BlackMagic Design Decklink HD Extreme 2

l BlackMagic Design Decklink HD Extreme 3

l BlackMagic Design Decklink Studio

l BlackMagic Design Decklink Studio 2

l BlackMagic Design Intensity Pro
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Licensing
The HardingFPA HDmust be licensed with a USB hardware protection key in order to run (see below).

Once it has been run on a particular computer, it will only be allowed to run on that same computer,

although there is limited scope for de-registering the product to move it to another computer (once per

week).

On first run, you will be asked if you wish to lock the software now:

Reregistering

If you move the USB protection key to a new computer and run the HardingFPA HD, you will be given the

option to transfer the licence to the new computer, as long as one week has passed since the last re-

registration / first registration. The re-registration screen is shown below:
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Only one re-registration is possible in a week long period, so be certain that you wish to move the licence

to the new computer, otherwise you will see the dialogue box below:

Applying Licence Updates

If required by Cambridge Research Systems, you may need to apply a v2c HASP Key update to your

system.

To do this, open theHASP Update Utility that was installed at the same time as the HardingFPA product:

Use the first tab to create a c2v file, which you can then email to Cambridge Research Systems.
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You will receive a v2c file with the update contained within it. Use the second tab to apply the update:
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Installation
Before continuing, note that the software locks itself to the current machine, but can be moved once per

week

The QuickTime framework is required in order for the system to operate. It can be obtained from:

http://www.apple.com/quicktime/download/

Once this is installed, the drivers for your capture card must be installed. These can be found on the

supplied installation media (USB memory).

This may ask you to install unsigned drivers, in which case, click on Continue Anyway each time. The

computer will also need to be restarted in order for the driver installation to complete. If you are upgrading

from previous versions of the Decklink drivers, you will need to uninstall the old ones and restart first.

To install the Harding software, run the installation package that can be found in the Install forWindows

or Install for OS X folders contained on the installation media.

http://www.apple.com/quicktime/download/
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Main Screen
Upon running the HardingFPA HD, the splash will be displayed during initialisation of the system and its

components:

The main screen for the HardingFPA HDwill then appear:

It displays a graphical representation of the characteristics of the analysed material, and some additional

advanced diagnostic information, so that the user may quickly and efficiently view the locations of failures

or cautions in the source material, and optionally play back the areas around these failures to aid in

rectifying the offending material. Its appearance is similar to both the HardingFPA-XL and HardingFPA-X

Viewer applications.

All functionality of the HardingFPA HD is performed from this screen.
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All of the buttons and sections of the HardingFPA HD screen have help text associated with them. To see

what a particular part of the interface does, simply hover the mouse cursor over the button/section.
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Customising Keyboard Shortcuts
All shortcuts in the software can be modified. To do this the software must be running as an administrator.

A menu item under the Tools menu then appears with the ability to Modify the shortcuts, and toReload

Default values. Once the values have been changed, the configuration for the shortcuts is stored in the file

HardingFPA_XX.xml (where XX is a codename for the particular HardingFPA software that is installed).

This file is placed in the executable directory onWindows, and in /Library/HfpaPreferences/ on

OS X. This file can then be backed up and/or copied to other HardingFPA installations if the same

shortcut configuration is required on more than one installation.

TheCustomise Keyboard Shortcuts window then appears:

Selecting a menu item displays its current shortcut. Click theCapture Key button to remap the shortcut for

the selected menu item, The screen changes to capture the key as shown below:
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At this point, press the key combination that is to be mapped to the shortcut for the select menu item. The

new shortcut is bound, and the screen changes to reflect this, as shown below:
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Version 3 Analysis Algorithms
HardingFPA software now features new analysis algorithms, which are better tuned to High Definition and

File-based work.

The Version 3 analysis algorithms are better suited to accommodate subtle changes in the image data,

and provide much closer results when testing the samematerial repurposed either into a different video

format, or encoded with a different codec. The main differences between the legacy algorithms and the

Version 3 algorithms are detailed below:

Different Graph Scaling

The HardingFPA generates risk values using the same range as its predecessor (i.e. 0 to 3.4) but displays

the graphical data using a revised vertical scale. This modified scale allocatesmuch more vertical space

for risk trace warnings and diagnostic trace steps but only displays risk traces up to the value of 3.0. Risk

traces values from 3.1 to 3.4 are still logged as part of the results files but are graphically displayed capped

at 3.0.
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(left) Version 2 and (right) Version 3 Graphing

The Squiggle

The HardingFPA gives enhanced visual diagnostics when an incoming transition coincides with an

outgoing transition from one exactly second earlier. The Version 3 algorithms insert a squiggle (see below)

to indicate when the diagnostic trace has simultaneously gained and lost a transition over the most recent

second between video frames.

Analysis Results

The Version 3 algorithms give results which are broadly similar to those generated by version 2.5. The

figure below shows the results of both versions when analysing the same video input under the same

guidelines:
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However, the results between the two versions will not be identical. The Version 3 algorithmswill, in

general, be more slightly more lenient to complex, rapid motion:
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... but more strict to examples of powerful, localised flashing:
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Most importantly of all, the Version 3 algorithms have been designed to be as format-agnostic as possible.

Changes in file formats or codecs will alter the underlying video data even if these changes are not visually

apparent. Here, the same video has been encoded at the same resolution using two different codecs. The

absolute differences between the two images are shown in the third image as deviations from mid grey.
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The Version 3 algorithms generate highly consistent results from different image resolutions and frame

rates. Here, the samemovie has been analysed in 720x576i50 and 640x480i60 formats. The only

noticeable difference is in the horizontal graph scale due to the different frame rates.

The graph below shows three sets of luminance flash risk results of the samemovie analysed in SD-

576i50, HD-720p50 and HD-1080i50 formats, and highlights the considerable similarities in the results:
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Language Support
All HardingFPA applications support multiple languages. In many of the applications, English and

Japanese can be selected from the Tools→ Languages menu. All applications will start up in the local

language by default, providing the translation files are present.

Note: only English and Japanese languages are currently officially supported, although you may translate

the applications yourself (see below).

To add a new language yourself, find the /languages/ subdirectory of the application bundle (on OS X) or

program directory (onWindows) and make a copy of each of the *.po files, replacing 'en' with the two letter

code for your locale (e.g. MainUnit.fr.po for French). You may then enter the strings after msgstr in this

file, between the "" quotation marks. Ensure the *.po files are saved in the UTF-8 format (without BOM).

An example is shown below for somemenus translated into Japanese. these would be stored in

xxxxx.jp.po.

#: main:rssettings

msgid "Settings"

msgstr "設定"

#: main:rshelp

msgid "Help"

msgstr "ヘルプ"

Note that on the OS X platform, youmust set one of the environment variables 'LC_ALL', 'LC_

MESSAGES' or 'LANG' to the two letter code for your locale (e.g. 'jp' for Japanese etc.) for the

applications to launch into your language automatically.
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Operation
The next subsections detail the operation of the HardingFPA software, including new features such as

FrameMasks.

Opening Sources

The HardingFPA operates on a system of Sources, whereby a source (which, depending on your

HardingFPA product, can be either a video feed from a tape machine, or a movie file) can be opened, and

is only analysed when the analyse button on the main window is clicked (movie files are automatically

analysed once they are opened). The currently opened source is always displayed below the controls on

the main window, and on startup displaysCurrent Source: None to depict the fact that no video source

has yet been opened. To open a new source, click theOpenNew Source button, shown below.

Clicking on theOpenNew Source button brings up one of the Source Selection dialogue boxes

(depending on the administrator setting) where you can choose which source to analyse from and may

enter additional information in the form of theMaterial Description, that you require to appear on the PDF

certificate or embedded into the results files that will be created from the analysis.

Opening a Source (Advanced Mode)

If the administrator has not selected the Simple Source Selection option, then the advanced Source

Selection screen will appear.

To open a feed from a capture card, select the tab with the name of your capture card and choose from

the input options and video formats. A number of timecode sources are supported, although in order to

use LTC, a working RS422 connection to a tape deck must be established. If you expect to see an input

connection or video format that is not displayed, then check in theAdministrator tab of the Settings that

the option has been enabled.

If you have the optional file-based module enabled, you can select a movie file in theMovie File tab by

clicking on the small button labelled "..", or choose a recently selected movie file from the drop-down

menu box. If you would like to clear this list at any time, click theClear List button underneath.
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The Timecode Source section of this window allows you to select various time code sources, as follows:

l Counter - A sequential timecode.

l VITC - Vertical Interval Timecode. The timecode is expected to be contained within the top lines of

the video, in the VITC format.

l LTC Serial - Linear Timecode over a serial port. The timecode is obtained from a connected tape

deck, over the RS422 port. in order to use this timecode source, the Tape Deckmust be connected

and communicating correctly.
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l VANC (RP188) - Vertical Ancillery Data Space. The timecode is expected to be stored in the

VANC format, as per the SMPTE-334M standard.

l System Time - Each frame is numbered by the time-of-day at which the frame was delivered to the

system.

l LTC Audio - Linear Timecode over audio input. The timecodes are expected to be delivered to the

audio input of the capture card in the LTC format.

The timecodes entering the system can be offset by selecting theOffset Timecode checkbox and

selecting the number of frames by which to offset the timecodes.

If you need to change the timecodes of the clip after analysis, or reloading, this can be done by

Renumbering Frames.

Analysis Area

If the selected Video Format is SD, the options to select which active area to analyse are displayed in the

window, as shown below. Select the correct Active Area for the material being analysed.
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When ready to analyse the source, clickOK and theCurrent Source notification on the main windowwill

change to reflect the chosen source, and if Movie Filewas selected, the analysis will automatically start.

Opening a Source (Simple Mode)

If the administrator has selected the Simple Source Selection option, then the Simple Source Selection

screen will appear.
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In this mode, the user only needs to click the mode they wish to analyse in.

The administrator specifies how the buttons behave by editing the file SourceList.ini, which is in the

program directory.

Video files can also be analysed by clickingOpenMovie. In this case the video standard will be overridden

to match the content of the video file.
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SourceList.ini

The administrator can specify exactly which options for sources can be selected in the Simple Source

Selection dialogue, by editing this file, that can be found in the program directory onWindows or in

/Library/HfpaPreferences/ on OS X. The sources will be arranged in rows of three, and any

number of sources can be added. If a blank space is required as in the example, simply set Name of the

source equal to "Off" and don't include any other fields.

The fields that can be set are:

Name: The string that is shown on the button.

AnalysisStandard: Which analysis standard the material will be analysed with.

DeviceInput: Which connection the material will be read from.

VideoFormat: Which video format the material is expected to be in.

TimecodeSource: The timecode source.

ActiveAreaArea: The active analysis area for the source.

OffsetTimecode: An offset value to apply to the timecodes entering the system. Can be positive or

negative.

The valid values for each of the fields are included at the top of the file. It is recommended that these

details are copied and pasted into the items, as any spelling mistakes will result in the source selection not

working properly.

Please note that your HASP Keymust have the appropriate licence enabled for the selected options to

work.

The file contents below are the default values that are included with the HardingFPA HD software.

# Valid Analysis Standards

# Ofcom (ITU), Japan NAB 2006

#
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# Valid Device Inputs

# Composite, Component, SVideo, SDI, HDMI

#

# Valid Video Formats

# PAL, NTSC, HD720p50, HD1080i50, HD720p59.94, HD1080i59.94, HD720p60,

# HD1080i60, HD1080p25, HD1080p29.97, HD1080p30, HD1080p50, HD1080p59.94,

# HD1080p60, HD1080p23.98, HD1080p24

#

# Valid TimeCode Sources

# Counter, VITC, LTC Serial, LTC Audio, VANC, System Time

#

# Valid Active Area

# Full, 43, 149, 149lb, 169

#

[Source1]

Name=HD-SDI

AnalysisStandard=Japan NAB 2006

DeviceInput=SDI

VideoFormat=HD1080i59.94

TimecodeSource=VITC

ActiveAreaArea=169

OffsetTimecode=0

[Source2]

Name=SD-SDI 16:9

AnalysisStandard=Japan NAB 2006
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DeviceInput=SDI

VideoFormat=NTSC

TimecodeSource=VITC

ActiveAreaArea=169

OffsetTimecode=0

[Source3]

Name=SD-SDI 4:3

AnalysisStandard=Japan NAB 2006

DeviceInput=SDI

VideoFormat=NTSC

TimecodeSource=VITC

ActiveAreaArea=43

OffsetTimecode=0

[Source4]

Name=Off

[Source5]

Name=S-Video 16:9

AnalysisStandard=Japan NAB 2006

DeviceInput=SVideo

VideoFormat=NTSC

TimecodeSource=VITC

ActiveAreaArea=169

OffsetTimecode=0

[Source6]

Name=S-Video 4:3
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AnalysisStandard=Japan NAB 2006

DeviceInput=SVideo

VideoFormat=NTSC

TimecodeSource=VITC

ActiveAreaArea=43

OffsetTimecode=0

[Source7]

Name=Off

[Source8]

Name=Video 16:9

AnalysisStandard=Japan NAB 2006

DeviceInput=Composite

VideoFormat=NTSC

TimecodeSource=VITC

ActiveAreaArea=169

OffsetTimecode=0

[Source9]

Name=Video 4:3

AnalysisStandard=Japan NAB 2006

DeviceInput=Composite

VideoFormat=NTSC

TimecodeSource=VITC

ActiveAreaArea=43

OffsetTimecode=0
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Source Passthrough

When a source has been successfully opened, the capture card will pass the signal through to its output.

This can be useful to view the input to the HardingFPA software on a secondarymonitor.

RS422 Tape Deck Control

If Serial (RS422) communications with the tape deck are established (this is performed automatically upon

opening a tape source), the tape control interface to the right of the Analysis Controls can be used to

control the attached tape deck. These controls only become active when a capture source has been

opened. The controls are available both on the main form and in a menu.

These can then be used to cue the tape to the correct point before the analysis starts. From left to right

and top to bottom these are:

Rewind, Play, Stop, Fast forward,

Jog Back, Jog Forward and Shuttle (variable speed forward and back).

Starting an analysis whilst tape control is enabled will cause the tape to automatically play, and stopping

analysis will automatically stop the tape.

Analysing a Source

To start analysing the current source, click the Start Analysis button in the Analysis Controls section, on

the left, shown below...
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Once the source is analysing the screen will appear similar to that shown below, and theOpenNew

Source button will change to a Stop Analysis button:

Whilst the analysis is being performed, a small red light in the Analysis Controls will flash to let you know

that a video source is still being analysed.

To stop the analysis, click the Stop Analysis button (the big blue square in the Analysis Controls panel).

When analysing a tape feed, this may only stop the capture, and the analysis will continue - if the disk

buffer (timecode in brackets under Analysis Timecode) has some frames left in it. To cancel the analysis

of these residual frames, press the Stop Analysis button a second time. Alternatively, wait for these

frames to complete.

Autosaving

If the options are set in AutosaveOptions, the HardingFPA HDwill automatically save out results files

using those configurable options to the folder specified, ready to be viewed again (SeeOpening a Saved

Analysis).

Renumbering Frames

After analysis is complete, or when a result has been reloaded, it is possible to renumber all of the frames

based on the current cursor position. To do this, first move the cursor to the frame you wish to renumber

and click the Set Frame Timecodes From Current Frame from theResults menu.
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Now type the required timecode values into the pop-up window:

WhenOK is clicked, all frames in the result will be appropriately renumbered.

Saving an Analysis

When results are loaded into the software, either from just performing an analysis or by loading results

from another results file, these results can be saved out again with different options by clicking on File ->

Save Results-> Save Results As. The same options are available as in the AutosaveOptions.
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Note however that if the currently loaded results set does not have all images, then selecting All Images

will only be able to save images where they exist on the currently loaded results.

Results can also be saved as a CSV file, using Save Results As CSV. This outputs all of the details of the

graph data as a comma separated variables file that is easily opened in spreadsheet software.

Saving a Selection

It is possible to save the marked selection of results as a separate set of files in order to make transferring

them easier. Set marker positions by either right-clicking on the graph or pressing the Page Up and Page

Down keys or by clicking on Set Results Start and Set Results End in the Results menu:

In the File -> Save Results menu, the Save Selection As... item can be found. Click this and the

following screen appears allowing the selected region to be saved.
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Images can be saved a configurable number of seconds around failures, and images can be omitted if the

material passes (by checking the boxOnly if material fails). Note however that if the currently loaded

results set does not have all images, then selecting All Images will only be able to save images where they

exist on the currently loaded results.

Opening a Saved Analysis

To open previously saved results, click on the Open results file button underneath the graph ( ) or click
on the File -> Open results filemenu. The following screen will then appear, showing all of the metadata

attached to the results files in the currently configured results folder. To change the folder contents

displayed in the table, click the button and select the new folder. To show all the
results in all subfolders of the selected folder, check the Include Subfolders box.
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Replay Functions

With results displayed in the graph window, the clip and graph can be played back to aid the rectification of

problem areas in the clip. TheGraph Controls panel underneath the graph contains buttons to facilitate

this replay functionality.

From left to right, the buttons perform the following functions...

Start Replay: Starts playback in real-time from the current position.

Stop Replay: Stops all playback.

Replay one second before and after current cursor position: Animate the images for one second before

and one second after the current cursor position whilst leaving the graph positioned at the current cursor

position. this is especially useful when you are looking for the causes of a particular failure and need to

look at the graph in detail and yet still see the offending section being played back.

Replay marked region: Replays from the Start marker to the End Marker. Set marker positions by either

right-clicking on the graph or pressing the Page Up and Page Down keys.

ZoomOut: Zoom the graph out.

Zoom In: Zoom the graph in to see the results more clearly.

In all playbackmodes, the playback will loop when reaching the end (after a small pause). The playback

can be stopped at any time with the Stop Playback menu item or button, by clicking anywhere on the

graph, by dragging the seek slider or by opening a new file.

Analysis Information

The table on the left hand side of the screen contains two tabs which display diagnostic information about

the clip. The Analysis Summary tab shows the following pieces of information, which are applicable to the

entire clip:
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Status: Showswhether the HardingFPA-X is reviewing results or in another state such as

loading/results/analysing/not loaded etc.

Video Source: The video standard of the analysis being viewed.

Filename: The filename or title of the source that was analysed to obtain the results currently being

displayed.

Analysis Timecode: The timecode of the final frame in the clip. This is expressed in hours : minutes :

seconds : frames.

Marked Length: The length of material currently marked off with Begin and Endmarkers. This is

expressed in hours : minutes : seconds : frames.

Recorded Length: The total length of the clip expressed in hours : minutes : seconds : frames.

Analysis Status: The Pass / Fail status of the clip with respect to the currently selected Flash and Pattern

guidelines.

Luminance Flash: The number of incidents and frames that have exceeded the test guidelines for

luminance flash.

Red Flash: The number of incidents and frames that exceed the test guidelines for red flash.

Spatial Patterns: The number of incidents and frames that have exceeded the test guidelines for spatial

patterns.
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Extended Failure: The number of incidents and frames that exceed the test guidelines for extended

failure. This represents the number of frames for which the black trace has appeared or equivalently, the

number of times that the maximum allowed number of flash warnings (levels 0.3 or 0.4) in the most recent

5 seconds has been exceeded.

In addition to this information, there is a second tab featuring Advanced Information. This tab contains

detailed information corresponding to the individual frame at the current cursor position, and may be of

use in determining the build up to a failure. The items described are as follows:

Luminance Diagnostic: This is the numerical value of the diagnostic plot shown on the graph. It

represents the minimum number of transitions which the most active 25% of the image frame has seen in

the most recent second.

Luminance Flash Area: The percentage area of the image frame which has exceeded the Flash

Guidelines.

Luminance Flash Contrast: The average contrast of the area of the image frame which has exceeded the

Flash Guidelines.

Extended FlashWarnings: The number of image frames which have generated flash warnings (levels 0.3

or 0.4) in the most recent 5 seconds.

RedDiagnostic: The number of red transitions which the most active 25% of the image frame has seen in

the most recent second.
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Red Flash Area: The percentage area of the image frame which has exceeded the Red Flash Guidelines.

Red Flash Contrast: The average amplitude of flash to and from saturated red of the area of the image

frame which has exceeded the Red Flash Guidelines.

Spatial Pattern Area: The percentage area of the image frame which has exceeded the Spatial Pattern

Guidelines.

Spatial Pattern Contrast: The average contrast of the area of the image frame which has exceeded the

Spatial Pattern Guidelines.

Frame Masks

The results include visual information in addition to the results images in the form of FrameMasks. These

mask images are overlaid on top of the frame images on the large image in the top-left of the main screen

and depict the locations of problem areas in the sequence, to aid in the repair of failing sequences.

When the results first appear on the graph, the large image in the top left hand side will appear as usual. In

order to utilise the framemask images, Click on the FrameMaskmenu, and select the type of failure that

you want to see the mask overlaid for:

When any of the framemasks are chosen from this box, the images will change and the mask will be

overlaid onto a darkened, black-and-white (monochrome) version of the original frame image. A frame will

appear around the image to depict the currently selected mask. An example is shown below:
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The colours represent the number of transitions which each pixel has experienced in the most recent

second after allowing for motion. The analyser will issue a failure when more than one quarter of the

image contains red or purple pixels. The same colour coding (shown below) is used for both luminance and

red flash analysis.

Pixel Colour Number of Transitions

none 0

green 1 or 2

yellow 3 or 4

orange 5 or 6

red 7 or 8

purple 9 or more

The spatial pattern mask data logs the activity which exceeds the spatial guideline limits as shown below:

The mask data appears as a set of uniformly coloured tiles in the image which represent how long they

have persisted in the image sequence. Spatial mask data only appears for stationary, regular patterns

which lead to failure. Any spatial patterns which drift, or are not regular, or do not persist in the video long

enough to trigger a failure are excluded.

Pixel Colour Persistence

none no regular stationary pattern present

green 0 to 1/6 second

yellow 1/6 to 1/3 second

orange 1/3 to 1/2 second

red more than 1/2 second = FAILURE

purple outside of pattern regularity limit
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The actual colours used represent how close the spatial pattern is to causing a failure rated in terms of how

long the pattern has persisted in the image sequence. When running under Ofcom guidelines, the

HardingFPA will only tolerate illegal spatial patterns to persist for up to half a second -- any longer than

this will lead to a failure. Therefore the green, yellow and orange colours denote the build up to failure

while red represents the actual failure itself. Purple is reserved for tiles which are part of the detected

spatial pattern but whose pattern characteristics lie outside of the allowable range when compared with

the rest of the spatial region. These purple tiles do not represent persistence and can accompany spatial

masks of any colour.

It is important to note that the HardingFPA only presentsmask colours for pixels whichwill go into

failure. This allows the editor to focus on the region(s) of the image which lead to the failure rather than

flooding the user with unnecessary information. As a result, many images will contain no masked /

coloured pixels even though there may be some flash or pattern activity occurring. However, all luminance

and red flashing activity is exposed in the mask data if an extended flash failure is either occurring or is due

to occur wihin the next 5 seconds.

In addition, framemask activity may suddenly disappear after an isolated failure sequence if the remaining

pixel transition activity does not lead to a subsequent failure.

Screenshots

The HardingFPA HD features a screenshot taking and printing function.

To take screenshot, press F12, click the camera ( ) icon underneath the graph, or select Take
Screenshot from the Tools menu. Screenshots will be saved to the location set in the Settings. Note that

the settingsmay be configured to delete all of the screenshots when closing the application.

Select View and Print Screenshots in the Tools menu to open following screen:
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Double-clicking an image will show it full-size.

Left clicking on a screenshot will select it.

Control-clicking on a screenshot will allowmultiple selection (for printing only).

ClickPrint to print the images:

Save Selected Images will save all of the images that have been selected in to a directory.

Images can be saved and deleted by using the Right-Click context menu:
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Settings
The settings for the HardingFPA HD can all be found by clicking on Tools -> Settings on the main screen.

The settings are separated into tabs, and the final two tabs (Administrator andHardingFPA-X) are only

shown if you are running the application as a user with administrator privileges.

Video Capture

These are the settings relating to the tape-based capturing of video feeds via aCapture Card.

The Spoolfile in this case refers to the hard drive buffer that is used to store frames from the incoming

video feed before they are passed to the analysis engine.

Spoolfile Location is the filename of the spoolfile on disk. For best performance when analysing High

Definition material, it is preferable to have this file on a different physical disk to the Autosave location.
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Max. Size is the maximum size of the circular spoolfile buffer. This is generally best left at the default

value of 1024 MB (1 GB), but if problems occur with dropped frames, this may be modified to alter the

performance of the buffering scheme.

Autosave Options

These are the settings relating to the Autosave feature, in which a results set is automatically saved

during analysis. It specifies the location of the autosaved PAP/PAR/PAM files (results files used by the

HardingFPA HD to display graph and mask data). Please note that the Autosave Locationmay be

overridden if HardingFPA-X Integration has been enabled.

Here there are also the options of when to save images in the results files, which can be selected as a

compromise between hard disk space and number of images saved. Images can be saved a configurable

number of seconds around failures, and images can be omitted if the material passes (by checking the box

Only if material fails).

PDF Certificate Options

These are the settings relating to the generation of HardingFPA PDF certificates.
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Material Description contains one setting, which defines whether the software will prompt the user to

confirm theMaterial Description every time a PDF is saved out.

PDF Detail refers to how verbose the PDF is to be:

Include Cautions will include data for regions of the analysis which are in theCaution range, as well as the

Fail range.

Detailed Results controls whether or not the PDF is to include data during failures. Without this being

selected, only the beginnings and ends of failing regions are included in the PDF.

PDF Images controls the frame previews in the PDF:

Show Frame Thumbnails selects whether or not to include images in the PDFs.

Screenshots

These are the settings relating to the Screenshot functionality.
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Screenshot Options contains settings for the Location, where the screenshots are to be saved when they

are made, and an option toDelete all screenshots when closing the application.

Display

These are the settings relating to the display of video frames in the interface.
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Image Thumbnails controls options relating to the smaller thumbnail images that displays the current live

captured image from theCapture Card in tape mode:

Enable Live Thumbnail window popout (Double-Click) allows the small live thumbnail to be double-

clicked to enable a pop-out hardware accelerated, resizable window.

Enable Full Screen Live Thumbnail (Single click on expanded window) allows the popped out window to

be clicked and enter full-screen mode.

Always display SD material as 4:3 in the image thumbnails will cause all SDmaterial (i.e. material with

less than 720 lines) to be displayed in the thumbnails in a 4:3 aspect ratio instead of the usual 16:9.

Analysis Results controls some settings relating to the results of testing:

Reload Previous Results on Startup toggles whether or not the application will reload the results that

were being displayed the last time it was running.
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Change the Application Icon to PASS/FAIL/CAUTION depending on the current result controls whether

the application's icon is to change along with the result status.

HardingFPA-X

These are the administrator's settings that only appear when the application is being run as an

administrator user (i.e. one with write permissions to the HKEY_LOCAL_MACHINE registry onWindows or

the /Library/HfpaPreferences directory on OS X). It is used to configure HardingFPA-X

Integration, whereby the results of analyses are entered into a HardingFPA-X SQL database for easy

integration with editor's workstations and easy sharing of results with editors via the use of the

HardingFPA-X cross-platform distributed system.

Please note these settings will override the AutosaveOptions, and autosaved files will be placed into the

HardingFPA-X folders instead.

Only enable the settings on this tab if you have a HardingFPA-X system already up and running.

Enable HardingFPA-X Integrationmust be checked to enable integration.

Root Path should match the (one of the) root path (s) of your HardingFPA-X Analyser.
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PAP/PAR Results is where the PAP/PAR/PAM results files (that are used by the HardingFPA Viewer

application) should be saved to when the analysis is complete.

PDF Results is where the PDF certificates are to be saved after the analysis is complete.

TheDatabase Settings should be set to point to your existing HardingFPA-X SQL Server:

Host Name: This is the host name or IP address of the computer on which the database is running. There

must be only one HardingFPA-X Database on the network for a given system.

Host Port: This is the port number of the database in the system. Unless this was changed during

installation, it should be left at its default value of 5432.

Any changesmade to the database settings will require the application to be restarted before the changes

are made.

Administrator

These are the administrator's settings that only appear when the application is being run as an

administrator user (i.e. one with write permissions to the HKEY_LOCAL_MACHINE registry onWindows or

the /Library/HfpaPreferences directory on OS X).
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Allowed Source Options provides a way for administrators to whitelist the connections and standards that

will be provided to the users. Use the arrow buttons to move the options between theDisallowed and

Allowed lists.

Analysis Options provides options relating to the actual analysis of video content:

Use SD Legacy Mode switches on SD Legacy Mode.

Analyse for potential subliminal frames switches on Subliminal Event Analysis.

Use simplified source selection dialog enables the Simple Source Selection screen when opening

sources for analysis.

Locking Tabs

The administrator additionally has the ability to Lock any of the Settings tabs so that normal usersmay not

edit the settings contained therein. To do this, start the application as an administrator and check the box

at the bottom of the required tab:
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HardingFPA-X Integration
HardingFPA-X Integration is used when your network already has aHardingFPA-X system that has been

fully configured and you wish the results of analyses to be entered into a HardingFPA-X SQL database for

easy integration with editor's workstations and easy sharing of results with editors via the use of the

HardingFPA-X cross-platform distributed system.

Integration must be configured by an Administrator user, and the settings are found on theHardingFPA-X

tab on the Settings window.

Once the database connection is established, any analyses on the HardingFPA HDwill save their results

and PDFs automatically to the configured folders, and will enter a completed job into the HardingFPA-X

Database.

Please refer to the HardingFPA-X manuals for more information on the Job lists andHardingFPA-X

system.
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SD Legacy Mode
The HardingFPA has a version 2.5 legacy analysis option for when comparisons with earlier HardingFPA

analyses are necessary (i.e. those that have come from versions 1.x of the HardingFPA-X, and to have

some level of compatibility with HardingFPA V2.5x SD-SDI Standalone tape-based systems).

If this has been enabled, it will be apparent in both the results graph interface and the generated PDF

certificate (see below).
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Subliminal Event Analysis
If enabled in the Settings, the system will test the incoming material for potential subliminal frames at the

same time as it is analysing for the usual flash and pattern criteria.

These frames will be identified on the graph visualisation as yellow circles, shown in the example below. A

yellow circle below the PASS/FAIL line indicates a subliminal warning, and one above the line indicates a

subliminal failure.

The appearance of the subliminal results can be switched on and off in the usual manner, by clicking on

the Subliminals yellow circle in the top-right corner of the graph.

What is a Subliminal Event?

The insertion of an image (or images) with contents different from the preceding or following images which

is too short for the viewer to be consciously aware of. The duration of a subliminal event is user-

configurable. The default settings are currently up to 0.05 seconds for a subliminal failure and up to 0.2

seconds for a subliminal warning. A subliminal event may be inserted at a scene change as it is not
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necessary for the images preceding and following the subliminal event to be similar. Additionally, a

subliminal event may involve inserted text or a change to only part of the image.

It is important to note that a subliminal event must contain information. An inserted blank image that is

black, white or uniform grey does not mean anything, and is therefore not regarded as subliminal.

Examples of subliminal and non-subliminal events

Example 1

This is a subliminal event because of the inserted images. The blue border in the 7th image shows the end

of the subliminal event.

Example 2

This is a subliminal event because of the inserted picture of a person's head. The blue border in the 7th

image shows the end of the subliminal event.

Example 3

This is a subliminal event because of the inserted text. The blue border in the 7th image shows the end of

the subliminal event.

Example 4
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This is not a subliminal event because the inserted images are just the inverse of the preceding and

following images and therefore contain no new information.

Example 5

This is not a subliminal event because the inserted images contain no information.

Example 6

This is not a subliminal event because none of the images contain any information.

Example 7

This is a subliminal event because the inserted images contain information. The blue border in the 7th

image shows the end of the subliminal event.

Example 8

This containsmore than one subliminal event as shown by the blue border images.

How does the HardingFPA Detect Subliminal Events?
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The HardingFPA searches for two sudden uncorrelated changes which occurred at different times but at

the same position in the image sequence. Changes which are blended in over several frames are not

considered as potentially subliminal as they would be consciously noticed by the viewer.

The HardingFPA can log the occurrences of two sudden uncorrelated changes and issue a subliminal

event or a subliminal warning depending on its duration. These are indicated as yellow dots above and

below the failure line respectively and are indications of where subliminal insertionsmay have occurred.

It is important to note that the HardingFPA may issue a large number of subliminal failures or warnings

especially when analysing rapidly flashing imagery. This does not necessarily mean that the video contains

a large number of subliminal insertions but merely that the HardingFPA has detected a large number of

potential candidates. It is ultimately up to the user to verify whether these flagged events constitute

subliminal insertions or benign uncorrelated changes.

Why does the HardingFPA indicate a subliminal event one frame after it has occurred?

The HardingFPA needs to detect the start and end times of any potential subliminal insertion to determine

whether the effect was rapid enough to be viewed subconsciously. Therefore, the HardingFPA can only

log a subliminal event after it has disappeared.
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Interpreting Results
It is important to note that material re-encoded at a different frame rate, will usually have a different

number of failed frames, and the results may differ because of the extra or missing frames that were

introduced during the conversion process.

The following items are phenomena commonly seen in the results along with explanations for the

behaviour.

1) A flash occurred but the normal flash risk trace didn’t appear – The main flash risk trace (dark

green line) may not appear if flashing is less than 20cd/m2 in contrast or if the flash frequency is

significantly within guideline limits. Remember that 2 opposing transitionsmake up a single flash.

The example below shows that two transitions have been detected by the diagnostic trace (light green line)

but that the main risk trace has not yet appeared because the flash frequency up to this point is not

considered to be significant.
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(1) Showing a flash but no flash risk trace

2) The flash risk trace (dark green line) appeared close to the pass-fail limit for a long sequence

of images but didn’t enter the fail zone – The system has detected flashing of above 3Hz and

20cd/m2 in amplitude; but the flash area is less than 25% of the screen area.  If the criteria for failure are

not all met then the system will generate a line based on how close the material is to failure.  If the line is

hovering just below the failure line then it might only need a tiny change in size of the flashing area to push

it into failure.  Such a tiny change could be introduced when converting between formats, frame rates or

codecs if this is not done carefully using professional grade codecs.

The example below shows that the flash risk has remained close to the failure line for long enough to

generate an extended flash failure. This occurs whenever more than 80% of the frames in the last five

seconds generated flash risk warnings of 0.3 or 0.4 (i.e. close to failure).
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(2) Long sequence of flashing that eventually led to an Extended Flash Failure

3) The flash risk trace (dark green line) persists for several frames after a flash occurred – This is

perfectly normal, and arises because of the way the system has to detect flashing frequencies over the

most recent second.  You do not need to worry about the persistence of the flash risk traces, you need to

principally examine the second before the line moves into failure, or where the diagnostics trace shows

that the transition count is still rising.  Once you have corrected all the causes of the line first moving into

failure then the material at that point will pass the test.  Note, however that lots of flashing close together

will generate a much longer compound failure: the best thing to do is deal with the flashes one at a time

until the material passes the test.
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(3) Flash graph persisting after the flash.

4) The diagnostic transition count increased where no obvious flash had occurred – The

diagnostic trace represents the number of transitions seen by the most active 25% of the screen over the

most recent second. Therefore continuous image activity (e.g. localised flashing and rapid movement

within the scene caused by camera pan or zoom etc) can steadily increase the number of transitions that

individual pixels have seen, and when at least 25% of those have seen an extra transition will the

diagnostic count increase. This can be quite trickymaterial to fix, and may only be possible by reducing the

brightness of the image or cut down on the whole area.
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(4) Transition count (light green trace) increased without an obvious transition

5) A flash clearly occurred but the diagnostic trace didn’t increase – The diagnostic trace shows

the number of transitions seen in the last second of material, and transitions older than that will be

discarded. This means that the diagnostic count may not always coincide with an obvious flash.  For

example, a visible transition in an image may not lead to a higher transition count if the pixels that see the

transition are not part of the most active 25%.
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(5) A flash clearly occurred but the diagnostic trace hasn’t increased.

Alternatively, an incoming transition may coincide with an outgoing transition from one exactly second

earlier. When this occurs, the new version 3 analyser inserts a squiggle (see picture with inset) to indicate

that the diagnostic trace has simultaneously gained and lost a transition over the most recent second

between video frames.
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6) The spatial pattern trace remains in the pass zone even though the detected spatial pattern

exceeds contrast and screen area limits – A number of limits have to be exceeded before a detected

spatial pattern can generate a failure. The Advanced Information tab in the example below shows that a

spatial pattern has been detected with 50 cd/m2 contrast (limit 20 cd/m2) and covers 46% screen area

(limit 40%). However, in this example, the system has not generated a failure because motion, caused by

the camera pan and zoom, makes the detected spatial pattern exempt from failure under Ofcom rules.
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7) The diagnostic trace decreased within a few frames after it had increased. Shouldn’t it have

taken one second for the transition to flush out? -- Not necessarily. It is true that the diagnostic trace

monitors transitions over the most recent second but the most active pixels that determine this diagnostic

count are, in most cases, constantly changing. The diagnostic trace will only follow this one-second pattern

if the most active pixels are changing together in phase.

The example below shows the diagnostic trace (light green) increasing from zero to one for a period of only

two frames (around the vertical amber current frame line) before returning to zero.
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8) The system passes a stationary pattern that looks as though it should have failed – Some

patterns that are clearly bar-like in one direction may also possess some local structure in the orthogonal

direction. Alternatively, a pattern may not be sufficiently regular or may not have sufficient contrast

throughout. Any such structure may cause the system to see fewer than 6 light-dark bars or may separate

a provocative pattern into two or more regions. Either of these mechanisms can save a provocative pattern

that would otherwise have failed.

The spatial pattern in the example below passes because of text and foreground objects which break up

the bar-like pattern into smaller irregular regions.
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9) The analyser generates spatial warnings but it’s not obvious where the pattern is! –

Occasionally the spatial trace may appear when there is no obvious spatial pattern present in the video

stream. The example below shows a picture of the sea generating spatial warnings caused by waves in

perspective creating faint, repeating structure. Other candidates for generating unexpected spatial

responses are: landscape in perspective, net curtains and reams of paper. However, it is highly unlikely

that any of these scenes would actually lead to a spatial pattern failure.
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10) Scene Changes (Japanese NAB Analysis only) - When analysing under Japanese NAB

guidelines, it is possible for the flash risk trace to go into failure while the diagnostic trace is still in the

caution zone (see image). This can occur if one of the transitions in the most recent second is classified as

a “scene change” (see bottom entry of the Advanced Information tab) where 80% of the image has seen a

significant luminance transition of 20IRE units or more. When this occurs, the maximum allowable number

of transitions is reduced from 6 down to 3 and, in this example, failure took place when the 4th transition

was detected.
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Interpreting the PDF
Test Certificate Page

(The following is an example, and details may vary)...
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Video Standard – This summarises the number of video lines, whether the video is progressively

scanned or interlaced and the frame (or field) rate per second. For example, a 576i60 video standard

denotes 576 video lines with interlaced fields at 60 fields per second whereas 576p30 denotes 576 video

lines with progressive frames at 30 frames per second. A frame represents a whole video image whereas

a field represents even or odd lines in a video image.

Video Scan – This will be blank if the video is progressively scanned or will state “upper (or lower) field

first” if the video is interlaced. The HardingFPA will state “assumed” upper (or lower) field first if the video

field order flags were not detected or not present. The assumed field order is derived from default field

orders for the specified video standard.

Frame Dimensions – This represents the width and height of the video picture in pixels. Please note that

all video feeds are resized and analysed in 16:9 format regardless of input video dimensions.

Active Area – Showswhich area of the frame was analysed to generate the results.

Summary of Results – This summarises the number of failed frames according to Red flash, Spatial

pattern and Luminance flash analysis plus a log of extended failures. The latter occurs when flash analysis

persists close to failure for several seconds. The HardingFPA will only generate a pass if there are no

failed frames in any category.

Analysis Results Pages
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RED – The results of red flash analysis in the range of 0.0 to 3.4. A value of 0.3 or 0.4 indicates a warning

while a value of 0.5 and above indicates failure. The number which follows in brackets represents the

number of transitions to or from a saturated red which have occurred in the most recent second.

SPAT – The results of spatial pattern analysis in the range of 0.0 to 3.4. A value of 0.3 or 0.4 indicates a

warning while a value of 0.5 and above indicates failure.

LUM – The results of luminance flash analysis in the range of 0.0 to 3.4. A value of 0.3 or 0.4 indicates a

warning while a value of 0.5 and above indicates failure. The number which follows in brackets represents

the number of luminance transitions which have occurred in the most recent second.

X – The presence or absence of an extended failure condition. This column will either be blank or will

contain an “X” symbol to indicate when an extended failure condition has occurred. An extended failure

occurs when luminance or red flash analysis generates warning values of 0.3 or 0.4 for at least 80% of the

most recent 5 seconds.
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IMAGE – The image column will normally contain the first and last images of the failed sequence. If the

failed sequence is too short to display both images, only the first image will be displayed. If the failed

sequence is longer than an entire page column, the first and last images for that column will also be

displayed.
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Licence Terms
This HardingFPA product utilises icons from the Silk icon set at

http://www.famfamfam.com/lab/icons/silk/ and the Fat Cow icon set at http://www.fatcow.com/free-

icons.

Some plugins use external libraries and makes extensive use of the following persons' or companies' code:

FFmpeg - Copyright (c) 2000-2011 Fabrice Bellard, et al.

http://www.ffmpeg.org/

The source and build instructions for the included FFmpeg libraries are contained on the HardingFPA-X

installation media.

FFmpeg is licensed under the LGPL Licence, duplicated below:

GNU LESSERGENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright (C) 1991, 1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts

as the successor of the GNU Library Public License, version 2, hence

the version number 2.1.]

Preamble

The licenses for most software are designed to take away your

freedom to share and change it. By contrast, the GNUGeneral Public

Licenses are intended to guarantee your freedom to share and change

http://www.famfamfam.com/lab/icons/silk/
http://www.fatcow.com/free-icons
http://www.fatcow.com/free-icons
http://www.ffmpeg.org/
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free software--to make sure the software is free for all its users.

This license, the Lesser General Public License, applies to some

specially designated software packages--typically libraries--of the

Free Software Foundation and other authors who decide to use it. You

can use it too, but we suggest you first think carefully about whether

this license or the ordinary General Public License is the better

strategy to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use,

not price. Our General Public Licenses are designed to make sure that

you have the freedom to distribute copies of free software (and charge

for this service if you wish); that you receive source code or can get

it if you want it; that you can change the software and use pieces of

it in new free programs; and that you are informed that you can do

these things.

To protect your rights, we need to make restrictions that forbid

distributors to deny you these rights or to ask you to surrender these

rights. These restrictions translate to certain responsibilities for

you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis

or for a fee, you must give the recipients all the rights that we gave

you. You must make sure that they, too, receive or can get the source

code. If you link other code with the library, you must provide

complete object files to the recipients, so that they can relink them

with the library after making changes to the library and recompiling

it. And you must show them these terms so they know their rights.
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We protect your rights with a two-step method: (1) we copyright the

library, and (2) we offer you this license, which gives you legal

permission to copy, distribute and/or modify the library.

To protect each distributor, we want to make it very clear that

there is no warranty for the free library. Also, if the library is

modified by someone else and passed on, the recipients should know

that what they have is not the original version, so that the original

author's reputation will not be affected by problems that might be

introduced by others.

Finally, software patents pose a constant threat to the existence of

any free program. We wish to make sure that a company cannot

effectively restrict the users of a free program by obtaining a

restrictive license from a patent holder. Therefore, we insist that

any patent license obtained for a version of the librarymust be

consistent with the full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the

ordinary GNUGeneral Public License. This license, the GNU Lesser

General Public License, applies to certain designated libraries, and

is quite different from the ordinary General Public License. We use

this license for certain libraries in order to permit linking those

libraries into non-free programs.

When a program is linked with a library, whether statically or using

a shared library, the combination of the two is legally speaking a

combined work, a derivative of the original library. The ordinary

General Public License therefore permits such linking only if the
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entire combination fits its criteria of freedom. The Lesser General

Public License permits more lax criteria for linking other code with

the library.

We call this license the "Lesser" General Public License because it

does Less to protect the user's freedom than the ordinary General

Public License. It also provides other free software developers Less

of an advantage over competing non-free programs. These disadvantages

are the reason we use the ordinary General Public License for many

libraries. However, the Lesser license provides advantages in certain

special circumstances.

For example, on rare occasions, there may be a special need to

encourage the widest possible use of a certain library, so that it becomes

a de-facto standard. To achieve this, non-free programsmust be

allowed to use the library. A more frequent case is that a free

library does the same job as widely used non-free libraries. In this

case, there is little to gain by limiting the free library to free

software only, so we use the Lesser General Public License.

In other cases, permission to use a particular library in non-free

programs enables a greater number of people to use a large body of

free software. For example, permission to use the GNUC Library in

non-free programs enablesmanymore people to use the whole GNU

operating system, as well as its variant, the GNU/Linux operating

system.

Although the Lesser General Public License is Less protective of the

users' freedom, it does ensure that the user of a program that is
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linked with the Library has the freedom and the wherewithal to run

that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and

modification follow. Pay close attention to the difference between a

"work based on the library" and a "work that uses the library". The

former contains code derived from the library, whereas the latter must

be combined with the library in order to run.

GNU LESSERGENERAL PUBLIC LICENSE

TERMS ANDCONDITIONS FORCOPYING, DISTRIBUTION ANDMODIFICATION

0. This License Agreement applies to any software library or other

program which contains a notice placed by the copyright holder or

other authorized party saying it may be distributed under the terms of

this Lesser General Public License (also called "this License").

Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data

prepared so as to be conveniently linked with application programs

(which use some of those functions and data) to form executables.

The "Library", below, refers to any such software library or work

which has been distributed under these terms. A "work based on the

Library" means either the Library or any derivative work under

copyright law: that is to say, a work containing the Library or a

portion of it, either verbatim or with modifications and/or translated

straightforwardly into another language. (Hereinafter, translation is

included without limitation in the term "modification".)

"Source code" for a workmeans the preferred form of the work for
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making modifications to it. For a library, complete source code means

all the source code for all modules it contains, plus any associated

interface definition files, plus the scripts used to control compilation

and installation of the library.

Activities other than copying, distribution and modification are not

covered by this License; they are outside its scope. The act of

running a program using the Library is not restricted, and output from

such a program is covered only if its contents constitute a work based

on the Library (independent of the use of the Library in a tool for

writing it). Whether that is true depends on what the Library does

and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the Library's

complete source code as you receive it, in anymedium, provided that

you conspicuously and appropriately publish on each copy an

appropriate copyright notice and disclaimer of warranty; keep intact

all the notices that refer to this License and to the absence of any

warranty; and distribute a copy of this License along with the

Library.

You may charge a fee for the physical act of transferring a copy,

and you may at your option offer warranty protection in exchange for a

fee.

2. You maymodify your copy or copies of the Library or any portion

of it, thus forming a work based on the Library, and copy and

distribute such modifications or work under the terms of Section 1
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above, provided that you also meet all of these conditions:

a) The modified workmust itself be a software library.

b) You must cause the filesmodified to carry prominent notices

stating that you changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no

charge to all third parties under the terms of this License.

d) If a facility in the modified Library refers to a function or a

table of data to be supplied by an application program that uses

the facility, other than as an argument passed when the facility

is invoked, then you must make a good faith effort to ensure that,

in the event an application does not supply such function or

table, the facility still operates, and performs whatever part of

its purpose remainsmeaningful.

(For example, a function in a library to compute square roots has

a purpose that is entirely well-defined independent of the

application. Therefore, Subsection 2d requires that any

application-supplied function or table used by this function must

be optional: if the application does not supply it, the square

root function must still compute square roots.)

These requirements apply to the modified work as a whole. If

identifiable sections of that work are not derived from the Library,

and can be reasonably considered independent and separate works in

themselves, then this License, and its terms, do not apply to those

sections when you distribute them as separate works. But when you

distribute the same sections as part of a whole which is a work based
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on the Library, the distribution of the whole must be on the terms of

this License, whose permissions for other licensees extend to the

entire whole, and thus to each and every part regardless of who wrote

it.

Thus, it is not the intent of this section to claim rights or contest

your rights to work written entirely by you; rather, the intent is to

exercise the right to control the distribution of derivative or

collective works based on the Library.

In addition, mere aggregation of another work not based on the Library

with the Library (or with a work based on the Library) on a volume of

a storage or distribution medium does not bring the other work under

the scope of this License.

3. You may opt to apply the terms of the ordinary GNUGeneral Public

License instead of this License to a given copy of the Library. To do

this, you must alter all the notices that refer to this License, so

that they refer to the ordinary GNUGeneral Public License, version 2,

instead of to this License. (If a newer version than version 2 of the

ordinary GNUGeneral Public License has appeared, then you can specify

that version instead if you wish.) Do not make any other change in

these notices.

Once this change is made in a given copy, it is irreversible for

that copy, so the ordinary GNUGeneral Public License applies to all

subsequent copies and derivative worksmade from that copy.

This option is useful when you wish to copy part of the code of

the Library into a program that is not a library.
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4. You may copy and distribute the Library (or a portion or

derivative of it, under Section 2) in object code or executable form

under the terms of Sections 1 and 2 above provided that you accompany

it with the complete corresponding machine-readable source code, which

must be distributed under the terms of Sections 1 and 2 above on a

medium customarily used for software interchange.

If distribution of object code is made by offering access to copy

from a designated place, then offering equivalent access to copy the

source code from the same place satisfies the requirement to

distribute the source code, even though third parties are not

compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the

Library, but is designed to work with the Library by being compiled or

linked with it, is called a "work that uses the Library". Such a

work, in isolation, is not a derivative work of the Library, and

therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library

creates an executable that is a derivative of the Library (because it

contains portions of the Library), rather than a "work that uses the

library". The executable is therefore covered by this License.

Section 6 states terms for distribution of such executables.

When a "work that uses the Library" usesmaterial from a header file

that is part of the Library, the object code for the workmay be a

derivative work of the Library even though the source code is not.

Whether this is true is especially significant if the work can be
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linked without the Library, or if the work is itself a library. The

threshold for this to be true is not precisely defined by law.

If such an object file uses only numerical parameters, data

structure layouts and accessors, and small macros and small inline

functions (ten lines or less in length), then the use of the object

file is unrestricted, regardless of whether it is legally a derivative

work. (Executables containing this object code plus portions of the

Library will still fall under Section 6.)

Otherwise, if the work is a derivative of the Library, you may

distribute the object code for the work under the terms of Section 6.

Any executables containing that work also fall under Section 6,

whether or not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or

link a "work that uses the Library" with the Library to produce a

work containing portions of the Library, and distribute that work

under terms of your choice, provided that the terms permit

modification of the work for the customer's own use and reverse

engineering for debugging such modifications.

You must give prominent notice with each copy of the work that the

Library is used in it and that the Library and its use are covered by

this License. You must supply a copy of this License. If the work

during execution displays copyright notices, you must include the

copyright notice for the Library among them, as well as a reference

directing the user to the copy of this License. Also, you must do one

of these things:
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a) Accompany the work with the complete corresponding

machine-readable source code for the Library including whatever

changes were used in the work (which must be distributed under

Sections 1 and 2 above); and, if the work is an executable linked

with the Library, with the complete machine-readable "work that

uses the Library", as object code and/or source code, so that the

user can modify the Library and then relink to produce a modified

executable containing the modified Library. (It is understood

that the user who changes the contents of definitions files in the

Library will not necessarily be able to recompile the application

to use the modified definitions.)

b) Use a suitable shared librarymechanism for linking with the

Library. A suitable mechanism is one that (1) uses at run time a

copy of the library already present on the user's computer system,

rather than copying library functions into the executable, and (2)

will operate properly with a modified version of the library, if

the user installs one, as long as the modified version is

interface-compatible with the version that the work wasmade with.

c) Accompany the work with a written offer, valid for at

least three years, to give the same user the materials

specified in Subsection 6a, above, for a charge no more

than the cost of performing this distribution.

d) If distribution of the work is made by offering access to copy

from a designated place, offer equivalent access to copy the above

specified materials from the same place.
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e) Verify that the user has already received a copy of these

materials or that you have already sent this user a copy.

For an executable, the required form of the "work that uses the

Library" must include any data and utility programs needed for

reproducing the executable from it. However, as a special exception,

the materials to be distributed need not include anything that is

normally distributed (in either source or binary form) with the major

components (compiler, kernel, and so on) of the operating system on

which the executable runs, unless that component itself accompanies

the executable.

It may happen that this requirement contradicts the license

restrictions of other proprietary libraries that do not normally

accompany the operating system. Such a contradiction means you cannot

use both them and the Library together in an executable that you

distribute.

7. You may place library facilities that are a work based on the

Library side-by-side in a single library together with other library

facilities not covered by this License, and distribute such a combined

library, provided that the separate distribution of the work based on

the Library and of the other library facilities is otherwise

permitted, and provided that you do these two things:

a) Accompany the combined library with a copy of the same work

based on the Library, uncombined with any other library

facilities. This must be distributed under the terms of the

Sections above.
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b) Give prominent notice with the combined library of the fact

that part of it is a work based on the Library, and explaining

where to find the accompanying uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute

the Library except as expressly provided under this License. Any

attempt otherwise to copy, modify, sublicense, link with, or

distribute the Library is void, and will automatically terminate your

rights under this License. However, parties who have received copies,

or rights, from you under this License will not have their licenses

terminated so long as such parties remain in full compliance.

9. You are not required to accept this License, since you have not

signed it. However, nothing else grants you permission to modify or

distribute the Library or its derivative works. These actions are

prohibited by law if you do not accept this License. Therefore, by

modifying or distributing the Library (or any work based on the

Library), you indicate your acceptance of this License to do so, and

all its terms and conditions for copying, distributing or modifying

the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the

Library), the recipient automatically receives a license from the

original licensor to copy, distribute, link with or modify the Library

subject to these terms and conditions. You may not impose any further

restrictions on the recipients' exercise of the rights granted herein.

You are not responsible for enforcing compliance by third parties with

this License.
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11. If, as a consequence of a court judgment or allegation of patent

infringement or for any other reason (not limited to patent issues),

conditions are imposed on you (whether by court order, agreement or

otherwise) that contradict the conditions of this License, they do not

excuse you from the conditions of this License. If you cannot

distribute so as to satisfy simultaneously your obligations under this

License and any other pertinent obligations, then as a consequence you

may not distribute the Library at all. For example, if a patent

license would not permit royalty-free redistribution of the Library by

all those who receive copies directly or indirectly through you, then

the only way you could satisfy both it and this License would be to

refrain entirely from distribution of the Library.

If any portion of this section is held invalid or unenforceable under any

particular circumstance, the balance of the section is intended to apply,

and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any

patents or other property right claims or to contest validity of any

such claims; this section has the sole purpose of protecting the

integrity of the free software distribution system which is

implemented by public license practices. Many people have made

generous contributions to the wide range of software distributed

through that system in reliance on consistent application of that

system; it is up to the author/donor to decide if he or she is willing

to distribute software through any other system and a licensee cannot

impose that choice.



Cambridge Research Systems Ltd.

Page 102 of 105

This section is intended to make thoroughly clear what is believed to

be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is restricted in

certain countries either by patents or by copyrighted interfaces, the

original copyright holder who places the Library under this License may add

an explicit geographical distribution limitation excluding those countries,

so that distribution is permitted only in or among countries not thus

excluded. In such case, this License incorporates the limitation as if

written in the body of this License.

13. The Free Software Foundation may publish revised and/or new

versions of the Lesser General Public License from time to time.

Such new versions will be similar in spirit to the present version,

but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library

specifies a version number of this License which applies to it and

"any later version", you have the option of following the terms and

conditions either of that version or of any later version published by

the Free Software Foundation. If the Library does not specify a

license version number, you may choose any version ever published by

the Free Software Foundation.

14. If you wish to incorporate parts of the Library into other free

programswhose distribution conditions are incompatible with these,

write to the author to ask for permission. For software which is

copyrighted by the Free Software Foundation, write to the Free

Software Foundation; we sometimesmake exceptions for this. Our
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decision will be guided by the two goals of preserving the free status

of all derivatives of our free software and of promoting the sharing

and reuse of software generally.

NOWARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO

WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.

EXCEPTWHENOTHERWISE STATED INWRITING THE COPYRIGHT HOLDERS AND/OR

OTHERPARTIES PROVIDE THE LIBRARY "AS IS" WITHOUTWARRANTY OF ANY

KIND, EITHEREXPRESSEDOR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIEDWARRANTIES OF MERCHANTABILITY AND FITNESS FORA PARTICULAR

PURPOSE. THE ENTIRE RISK AS TO THE QUALITY ANDPERFORMANCE OF THE

LIBRARY IS WITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOUASSUME

THE COST OF ALL NECESSARY SERVICING, REPAIRORCORRECTION.

16. IN NO EVENT UNLESS REQUIREDBY APPLICABLE LAWORAGREED TO IN

WRITINGWILL ANY COPYRIGHT HOLDER, ORANY OTHERPARTY WHOMAY MODIFY

AND/ORREDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU

FORDAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR

CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE

LIBRARY (INCLUDING BUT NOT LIMITED TO LOSS OF DATA ORDATA BEING

RENDERED INACCURATE OR LOSSES SUSTAINEDBY YOUORTHIRD PARTIES ORA

FAILURE OF THE LIBRARY TOOPERATE WITH ANY OTHERSOFTWARE), EVEN IF

SUCHHOLDEROROTHERPARTY HAS BEENADVISEDOF THE POSSIBILITY OF SUCH

DAMAGES.

ENDOF TERMS ANDCONDITIONS

How to Apply These Terms to Your New Libraries
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If you develop a new library, and you want it to be of the greatest

possible use to the public, we recommend making it free software that

everyone can redistribute and change. You can do so by permitting

redistribution under these terms (or, alternatively, under the terms of the

ordinary General Public License).

To apply these terms, attach the following notices to the library. It is

safest to attach them to the start of each source file to most effectively

convey the exclusion of warranty; and each file should have at least the

"copyright" line and a pointer to where the full notice is found.

<one line to give the library's name and a brief idea of what it does.>

Copyright (C) <year> <name of author>

This library is free software; you can redistribute it and/or

modify it under the terms of the GNU Lesser General Public

License as published by the Free Software Foundation; either

version 2.1 of the License, or (at your option) any later version.

This library is distributed in the hope that it will be useful,

but WITHOUT ANY WARRANTY; without even the implied warranty of

MERCHANTABILITY or FITNESS FORA PARTICULARPURPOSE. See the GNU

Lesser General Public License for more details.

You should have received a copy of the GNU Lesser General Public

License along with this library; if not, write to the Free Software

Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Also add information on how to contact you by electronic and paper mail.

You should also get your employer (if you work as a programmer) or your

school, if any, to sign a "copyright disclaimer" for the library, if
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necessary. Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the

library `Frob' (a library for tweaking knobs) written by James Random Hacker.

<signature of Ty Coon>, 1 April 1990

Ty Coon, President of Vice

That's all there is to it!
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